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Overview

Product Overview

The RocketPort EXPRESS is a high-speed in-server serial expansion card that is 
RS-232/422/485 software-selectable for use in a PCI-Express (PCIe) compatible 
slot in a host system. The RocketPort EXPRESS was designed to support speeds 
up to 921Kbps (if connected, using fan-out cables or the 4J/8J models) or 
460.8Kbps (if using an interface box).
The RocketPort EXPRESS series uses Comtrol Application Specific Integrated 
Circuit (ASIC) technology to replace most hardware functionality to minimize 
components, including:
• The processor
• A serial controller
• Bus interface logic and other miscellaneous logic
You can install up to four RocketPort EXPRESS cards in one computer, providing a 
maximum of 128 additional serial ports. 

Before Installing the RocketPort EXPRESS

If you are planning on installing the RocketPort EXPRESS in a Windows system 
make sure that you have placed the device driver assembly to a location that is 
available to the host system before installing the card in the host. 
You can use the links in the following table to locate the latest device drivers and 
documentation.
You may want to record the model and serial number of the RocketPort EXPRESS 
before installing the card in the event you need to call technical support.

Locating the Latest Drivers and Documentation

This table contains links the software and installation documentation.

Software or 
Document Location

Device drivers http://downloads.comtrol.com/html/rp_express_drivers.htm

Diagnostic and 
Utilities http://downloads.comtrol.com/html/rp_express_diag.htm

User Guides http://downloads.comtrol.com/html/rp_express_docs.htm

http://downloads.comtrol.com/html/rp_express_drivers.htm
http://downloads.comtrol.com/html/rp_express_diag.htm
http://downloads.comtrol.com/html/rp_express_docs.htm
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Card and Interface Installation

This section discusses the following:
• Installing the Card
• Attaching a Quad/Octacable Interface Cable on Page 8
• Attaching an Interface Box on Page 9
• Installing a Rackmount Interface Box on Page 10

Installing the Card

Use the following procedure to install a RocketPort EXPRESS card.
1. Turn off the host computer. 
2. Remove the system cover from your computer.
3. Select a PCI-Express (PCIe) compatible slot.
4. Remove the slot cover or release the clamp.
5. Insert the card into the slot and seat it securely. 
6. Reinstall the expansion slot retaining screw or clamp.

Do not connect an interface to the card when the host 
system is powered on, this can cause the card to fail.

7. If this is not a 4J or 8J (RJ45/11 connector integrated in the card bracket), 
attach the interface that came with your card using the appropriate 
procedure:
• Attaching a Quad/Octacable Interface Cable on Page 8
• Attaching an Interface Box on Page 9
• Installing a Rackmount Interface Box on Page 10

8. If this is a 4J or 8J installation, see Connecting Serial Devices on Page 11 for 
cabling information after driver installation.
a. Tighten the retaining screws.
b. Replace the system cover on your computer.
c. Power on your host system.
d. Click Cancel if a Found New Hardware message appears on a Windows 

operating system. 

Execute the device driver assembly to start the driver installation. For 
other operating system device drivers, see  Locating the Latest Drivers 
and Documentation on Page 5.

e. After installing the device driver, you should verify that the ports are 
functioning properly and then connect your serial devices. You can use the 
Troubleshooting section on Page 25 for port testing procedures for your 
operating system. Refer to Connecting Serial Devices on Page 11 for 
information about connecting serial devices.

Caution
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Attaching a Quad/Octacable Interface Cable

Attaching a Quad/Octacable Interface Cable

Use this procedure to complete the quadcable or octacable installation.
1. Make sure that the host system is powered off before connecting the cable.
2. Attach the 68-pin end of the quadcable or octacable to the card. 

Make sure that the 
connectors are properly 
aligned and forcefully push 
the connector of the Quad/
Octacable with a rocking 
motion into the card 
connector. Make sure that 
the connector is seated 
tightly before tightening the 
retaining screws on the 
connector.

3. Tighten the retaining screws. 
4. Power on the host system.
5. Click Cancel if a Found New Hardware message appears on a Windows 

operating system.
Execute the device driver assembly to start the driver installation.
For other operating system device drivers, see Locating the Latest Drivers and 
Documentation on Page 5.

6. After installing the driver, you should verify that the ports are functioning 
properly and then connect your serial devices. 
You can use the Troubleshooting section on Page 25 for port testing 
procedures.
Refer to Connecting Serial Devices on Page 11 for information about 
connecting serial devices.

Octacable

Quadcable

DB9

DB25

Caution
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Attaching an Interface Box

Attaching an Interface Box

Use this procedure to complete the installation with an interface box.
Do not connect the cable to the RocketPort EXPRESS 
card or interface box when the computer is powered 
on. The interface is not hot-swappable.

Connecting the cable to the RocketPort EXPRESS 
card or interface box while the computer is powered 
on may damage the electronics on the card or 
interface box.

1. Make sure that the host system is powered off before 
connecting the cable.

2. Attach the LFH60 end of the interface cable to the 
RocketPort EXPRESS card and the DB37 end to the 
connector the interface box. 

Make sure that the connectors are properly aligned. Do NOT use force 
when connecting the cables to the host adapter card.
Note: The 32-port card uses a Y-cable that is labeled 1-16 and 17-32 on the 

connectors.
3. Tighten the retaining screws.
4. Power on the host system.
5. Click Cancel if a Found New Hardware message appears on a Windows 

operating system.
Execute the device driver assembly to start the driver installation.
For other operating system device drivers, see Locating the Latest Drivers and 
Documentation on Page 5.

6. After installing the driver, you should verify that the ports are functioning 
properly and then connect your serial devices. 
You can use the Troubleshooting section on Page 25 for port testing 
procedures.
Refer to Connecting Serial Devices on Page 11 for information about 
connecting serial devices.

Caution

DB37

LFH60

Caution
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Installing a Rackmount Interface Box

Installing a Rackmount Interface Box

Rackmount interface boxes are sturdy enough to allow you to stack several units 
on a shelf, or you can mount it directly into a rack.

Do not connect the cable to the RocketPort EXPRESS card or interface 
box when the computer is powered on. The interface is not hot-
swappable.

Connecting the cable to the RocketPort EXPRESS card or interface box 
while the computer is powered on may damage the electronics on the 
card or interface box.

1. Make sure that the host system is powered off before connecting the cable.
2. Place the Rackmount interface box on a stable surface or attach the brackets 

to the interface box using the screws supplied with the unit and attach the 
bracket into your rack.

3. Attach the cable shipped with the card between the interface box and the card.
Make sure that the connectors are properly aligned. Do NOT use force 
when connecting the cables to the host adapter card. 
Do not connect 16-port cards located in various machines to the 32-
port Rackmount. It is possible to damage the interface box and card if 
the interface box is connected to two PCs using separate line power 
sources.

4. Power on the host system.
5. Click Cancel if a Found New Hardware message appears on a Windows 

operating system.
Execute the device driver assembly to start the driver installation.
For other operating system device drivers, see Locating the Latest Drivers and 
Documentation on Page 5.

6. After installing the driver, you should verify that the ports are functioning 
properly and then connect your serial devices. 
You can use the Troubleshooting section on Page 25 for port testing 
procedures.
Refer to Connecting Serial Devices on Page 11 for information about 
connecting serial devices.

The receive LED is lit if connected to an RS-232/422/485 device. 
The transmit LED is illuminated when RS-232/422/485 data is being 
transmitted. Noticeable flashing occurs only if transmit data starts and stops 
a few times per second or less. Otherwise, if data is being transmitted 
continuously, the LED illumination appears to be constant. If no data is 
transmitted the LED is off.

Caution

Caution

Rx Tx Each port has transmit and receive LEDs.
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Connecting Serial Devices

This section provides information about the RocketPort EXPRESS connectors, in 
the event that you need to build cables or loopback plugs. 
• DB9 Serial Cables and Loopback Plugs on Page 11
• DB25 Serial Cables and Loopback Plugs on Page 14
• RJ45 Serial Cables and Loopback Plugs on Page 17
• RJ11 Serial Cables and Loopback Plugs on Page 19
A loopback plug is a serial port plug with pins wired together that you can use 
with an application (for example, the diagnostic, Test Terminal, or minicom) to 
test serial ports. See Before Calling Technical Support on Page 25 for information 
about using the test application shipped with the RocketPort EXPRESS.

DTE Versus DCE

Most devices, except modems, are Data Terminal Equipment (DTE) devices. 
Modems are Data Communication Equipment (DCE) devices. RocketPort 
EXPRESS ports are configured as DTE. 
How you build a cable depends on which device your are connecting to (DTE or 
DCE). For example, you need a null-modem cable to connect the COM ports 
(COM1 or COM2) on the computer or the RocketPort EXPRESS ports to printers, 
terminals, bar code readers or DNC equipment. If you are connecting a DTE 
device to a DCE device you need a straight-through modem cable. 
• Straight-through cable (DTE to DCE) - connects TxD to TxD and RxD to RxD. 
• Null-modem cable (DTE to DTE) - connects TxD to RxD and RxD to TxD.

DB9 Serial Cables and Loopback Plugs

The following figures and table illustrate the signals present on DB9 connectors if 
you need to build your own null-modem or straight-through DB9 serial cables. 
Quadcable, octacable, and the interface boxes use DB9 male connectors.
• DB9 Signals on Page 12
• DB9 Null-Modem Cables (RS-232) on Page 12
• DB9 Null-Modem Cables (RS-422 or RS-485 Full-Duplex) on Page 12
• DB9 Straight-Through Cables (RS-232 or RS-485 Half-Duplex) on Page 13
• DB9 Loopback Plugs on Page 13
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DB9 Signals

DB9 Signals Refer to the manufacturer’s installation documentation if you need help with the 
connector pinouts or cabling for the serial device. 

DB9 Null-Modem 
Cables (RS-232)

Use the following figure if you need to build an RS-232 null-modem cable. A null-
modem cable is required for connecting DTE devices. 
If you need RTS-CTS/DTR-DSR 
hardware flow control, you can use 
the pinouts provided in the 
following example.
You may want to purchase or build 
a straight-through cable and 
purchase a null-modem adapter. 
For example, a null-modem cable 
can be used to connect COM2 of 
one PC to COM2 of another PC.
Note: RJ45 connectors are not 

standardized. Refer to your 
serial device documentation 
for signal information.

DB9 Null-Modem 
Cables (RS-422 or 
RS-485 Full-Duplex)

Use the following figure if you need to build 
an RS-422 or RS-485 full-duplex null-modem 
cable. A null-modem cable is required for 
connecting DTE devices.
Note: RS-422 and RS-45 signals are not 

standardized and each serial 
manufacturer uses different pinouts. 
Refer to the serial device 
documentation to determine the 
pinouts for the signals above.

DB9 Male Connector Signals

Pin RS-232 RS-422 RS-485
(Full-Duplex)

RS-485
(Half-Duplex)

1 DCD Not used Not used Not used

2 RxD RxD- RxD- Not used

3 TxD TxD- TxD- TRxD-

4 DTR Not used Not used Not used

5 SIG GND SIG GND SIG GND SIG GND

6 DSR Not used Not used Not used

7 RTS TxD+ TxD+ TRxD+

8 CTS RxD+ RxD+ Not used

9 RI Not used Not Used Not Used

Ground must be tied to signal ground.

Pin 1 Pin 5

Pin 6 Pin 9

TxD
RxD
RTS

CTS
DSR

GND

DCD
DTR

Signal
RxD
TxD
CTS

RTS
DTR

GND

DCD
DSR

Signal
DB9

2
3
8

7
4

5

1
6

Pins
DB25

3
2

4

7

8
6

Pins

20

5

 
 DB9

3
2
7

8
6

5

1
4

 Pins

RI RI9 229

RocketPort DTE Serial Device

TxD+
TxD-
RxD+

Signal
 DB9

7
3
8

 Pins
RxD+
RxD-

Signal

TxD+
TxD-RxD-          2     

RocketPort DTE Serial
Device
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DB9 Straight-Through Cables (RS-232 or RS-485 Half-Duplex)

DB9 Straight-
Through Cables (RS-
232 or RS-485 Half-
Duplex)

Use the following figure if 
you need to build an RS-
232 or RS-485 half-duplex 
straight-through cable. 
Straight-through cables 
are used to connect 
modems and other DTE 
devices. For example, a 
straight-through cable can 
be used to connect COM2 
of one PC to a modem. 
Note: RJ45 connectors are 

not standardized. 
Refer to your serial 
device documentation for signal information.

DB9 Loopback Plugs RocketPort EXPRESS models with DB9 connectors on 
the interface are shipped with a a single loopback plug 
(RS-232/422).
Wire the following pins together to build additional 
plugs or replace a missing RS-232/422 loopback plug.
• Pins 1 to 4 to 6
• Pins 2 to 3
• Pins 7 to 8 to 9
Wire these pins together if you want to build an RS-422 (only) loopback plug.
• Pins 2 to 3
• Pins 7 to 8

DB9

1
2
3
4
5

8

6
7

Pins
DCD
RxD
TxD or TRxD-
DTR
GND

CTS

DSR
RTS or TRxD+

Signal
DB9

1
2
3
4
5

8

6
7

Pins
DCD
RxD
TxD or TRxD-
DTR
GND

CTS

DSR
RTS or TRxD+

Signal

RI 9 9 RI

DB25

8
3
2
20
7

5

6
4

Pins

22

RocketPort DCE Serial Device

Pin 1 Pin 5

Pin 6 Pin 9

 RS-232/422 (Back View)



14 - Connecting Serial Devices RocketPort EXPRESS User Guide: 2000481 Rev. G

DB25 Serial Cables and Loopback Plugs

DB25 Serial Cables and Loopback Plugs

This section describes DB25 cables and loopback plugs for the following models:
• Fan-out Cable Signals (quadcable and octacable) 
• Interface Box Signals on Page 15 (standard and surge models)
• DB25 Null-Modem Cables (RS-232) on Page 15
• DB25 Null-Modem Cables (RS-422 or RS-485 Full-Duplex) on Page 16
• DB25 Straight-Through Cables (RS-232 or RS-485 Half-Duplex) on Page 16
• DB25M: Fan-out Cable Loopback Plugs on Page 16
• DB25F: Standard Interface Box on Page 16
• DB25M: Surge Interface Box Loopback Plugs on Page 17
Note: Refer to the manufacturer’s installation documentation if you need help 

with connector pinouts or cabling for the serial device.

Fan-out Cable 
Signals

Refer to the manufacturer’s installation documentation if you need help with the 
connector pinouts or cabling for the serial device. 

DB25 Male Connector Signals (Quad/Octacables)

Pin RS-232 RS-422 RS-485
(Full-Duplex)

RS-485
(Half-Duplex)

1 Not used Not used Not used Not used

2 TxD TxD- TxD- TRxD-

3 RxD RxD- RxD- Not used

4 RTS TxD+ TxD+ TRxD+

5 CTS RxD+ RxD+ Not used

6 DSR Not used Not used Not used

7 SIG GND SIG GND SIG GND SIG GND

8 DCD Not used Not used Not used

9 to 19 Not used Not used Not used Not used

20 DTR Not used Not used Not used

21 Not used Not used Not used Not used

22 RI Not used Not used Not used

23-25 Not used Not used Not used Not used

Ground must be tied to signal ground.

Pin 14 Pin 25

Pin 1 Pin 13
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Interface Box Signals

Interface Box 
Signals

Refer to the manufacturer’s installation documentation if you need help with the 
connector pinouts or cabling for the serial device. 

DB25 Null-Modem 
Cables (RS-232)

Use the following figure if you 
need to build an RS-232 null-
modem cable. A null-modem 
cable is required for 
connecting DTE devices.
You may want to purchase or 
build a straight-through cable 
and purchase a null-modem 
adapter. For example, a null-
modem cable can be used to 
connect COM2 of one PC to 
COM2 of another PC.
Note: RJ45 connectors are not 

standardized. Refer to 
your serial device 
documentation for 
signal information.

DB25 Female (Standard Interface Box) and 
DB 25 Male (Surge Interface Box)

Connector Signals

Pin RS-232 RS-422 RS-485
(Full-Duplex)

RS-485
(Half-Duplex)

1 Not used Not used Not used Not used

2 TxD TxD- TxD- TRxD-

3 RxD RxD- RxD- Not used

4 RTS TxD+ TxD+ TRxD+

5 CTS RxD+ RxD+ Not used

6 DSR Not used Not used Not used

7 SIG GND SIG GND SIG GND SIG GND

8 DCD Not used Not used Not used

15 CTS RxD+ RxD+ Not used

17 RxD RxD- RxD- Not used

19 RTS TxD+ TxD+ TRxD+

20 DTR Not used Not used Not used

21 Not used Not used Not used Not used

22 RI Not used Not used Not used

23-24 Not used Not used Not used Not used

25 TxD TxD- TxD- TRxD-

Ground must be tied to signal ground.

Pin 14 Pin 25

Pin 1 Pin 13

Male
Pin 25 Pin 14

Pin 13 Pin 1

Female

TxD*
RxD*
RTS*

CTS*
DSR

GND

DCD
DTR

Signal
RxD
TxD
CTS

RTS
DTR

GND

DCD
DSR

Signal
DB9

2
3
8

7
4

5

1
6

Pins
DB25

3
2

4

7

8
6

Pins

20

5

 
 DB25

2
3
4

5
6

7

8
20

 Pins

RI RI9 2222

RocketPort DTE Serial Device

*  Interface boxes have alternate pins available for this
    signal. Refer to Interface Box Signals for additional
    information. 
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DB25 Null-Modem Cables (RS-422 or RS-485 Full-Duplex)

DB25 Null-Modem 
Cables (RS-422 or 
RS-485 Full-Duplex)

Use the following figure if you need to build an 
RS-422 or RS-485 full-duplex null-modem 
cable. A null-modem cable is required for 
connecting DTE devices.
Interface boxes have optional pins available 
for these signals. Refer to Interface Box 
Signals on Page 15 for more information.
Note: RS-422 and RS-485 signals are not 

standardized and each serial 
manufacturer uses different pinouts. Refer to the serial device 
documentation to determine the pinouts for the signals above.

DB25 Straight-
Through Cables (RS-
232 or RS-485 Half-
Duplex)

Use the following figure 
if you need to build an 
RS-232 or RS-485 half-
duplex straight-through 
cable. Straight-through 
cables are used to 
connect modems and 
other DTE devices. For 
example, a straight-
through cable can be 
used to connect COM2 
of one PC to a modem. 

DB25M: Fan-out 
Cable Loopback 
Plugs

RocketPort EXPRESS models with DB25 male connectors on the interface are 
shipped with a a single loopback plug (RS-232/422).
Wire the following pins together to build additional 
RS-232/422 plugs or replace a missing RS-232/422 
loopback plug.
• Pins 2 to 3
• Pins 4 to 5 to 22
• Pins 6 to 8 to 20
You can wire the following pins together for an RS-422 only loopback plug.
• Pins 2 to 3
• Pins 4 to 5

DB25F: Standard 
Interface Box

RocketPort EXPRESS models with DB25 female connectors on the interface box 
are shipped with a a single loopback plug (RS-232/422).
Wire the following pins together to build additional 
RS-232/422 plugs or replace a missing RS-232/422 
loopback plug.
• Pins 2 to 3 or alternately, Pins 25 to 17
• Pins 4 to 5 to 22 or alternately, Pins 19 to 15 to 22
• Pins 6 to 8 to 20
You can wire the following pins together for an RS-422 only loopback plug.
• Pins 2 to 3 or alternately, Pins 17 to 25
• Pins 4 to 5 or alternately, Pins 15 to 19

TxD+
TxD-
RxD+

Signal
 DB25

4
2
5

 Pins
RxD+
RxD-

Signal

TxD+
TxD-RxD-          3    

RocketPort DTE Serial
Device

DB9

1
2
3
4
5

8

6
7

Pins
DCD
RxD
TxD or TRxD-
DTR
GND

CTS

DSR
RTS or TRxD+

Signal
DB25

8
3
2
20
7

5

6
4

Pins
DCD
RxD*
TxD* or TRxD-
DTR
GND

CTS*

DSR
RTS* or TRxD+

Signal

RI 22 9 RI

DB25

8
3
2
20
7

5

6
4

Pins

22

RocketPort DCE Serial Device

*  Interface boxes have alternate pins available for this signal.
   Refer to Interface Box Signals for more information. 

Pin 13Pin 1

RS-232/422 (Back View)

Pin 14 Pin 25Male

Pin 13 Pin 1

RS-232/422 (Back View)

Pin 14Pin 25
Female
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DB25M: Surge Interface Box Loopback Plugs

DB25M: Surge 
Interface Box 
Loopback Plugs

RocketPort EXPRESS models with DB25 male connectors on the Surge interface 
box are shipped with a a single loopback plug (RS-232/422).
Wire the following pins together to build additional 
RS-232/422 plugs or replace a missing RS-232/422 
loopback plug.
• Pins 2 to 3 or alternately, Pins 17 to 25
• Pins 4 to 5 to 22 or alternately, Pins 15 to 19 to 22
• Pins 6 to 8 to 20
You can wire the following pins together for an RS-422 only loopback plug.
• Pins 2 to 3 or alternately, Pins 17 to 25
• Pins 4 to 5 or alternately, Pins 15 to 19

RJ45 Serial Cables and Loopback Plugs

This section describes RJ45 cables and loopback plugs for the RocketPort 
EXPRESS 4J, Octacable and Rackmount interface boxes.
• RJ45 Signals
• RJ45 Null-Modem Cable (RS-232) on Page 18
• RJ45 Null-Modem Cable (RS-422 or RS-485 Full-Duplex) on Page 18
• RJ45 Straight-Through Cable (RS-232 or RS-485 Half-Duplex) on Page 18
• RJ45 Loopback Plugs on Page 18

RJ45 Signals There are no standards for RJ45 connector pinouts. Refer to the 
manufacturer’s installation documentation if you need help with 
connector pinouts or cabling for the serial device.
Note: Ring indicator is not supported on the RJ45 connector.

Pin 13Pin 1

RS-232/422 (Back View)

Pin 14 Pin 25

RJ45 Connector Signals

Pin RS-232 RS-422 RS-485
(Full-Duplex)

RS-485
(Half-Duplex)

1 RTS TxD+ TxD+ TRxD+

2 DTR Not Used Not Used Not Used

3 SIG GND SIG GND SIG GND SIG GND

4 TxD TxD- TxD- TRxD-

5 RxD RxD- RxD- Not Used

6 DCD Not Used Not Used Not Used

7 DSR Not Used Not Used Not Used

8 CTS RxD+ RxD+ Not Used

Ground must be tied to signal ground.
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RJ45 Null-Modem Cable (RS-232)

RJ45 Null-Modem 
Cable (RS-232)

Use the following figure if you need 
to build an RS-232 null-modem cable. 
A null-modem cable is required for 
connecting DTE devices.

RJ45 Null-Modem 
Cable (RS-422 or RS-
485 Full-Duplex)

Use the following figure if you need to build 
an RS-422 null-modem cable. A null-modem 
cable is required for connecting DTE 
devices.
Note: RS-422 pinouts are not standardized. 

Each serial manufacturer uses 
various pinouts. Please refer to the 
documentation for the serial to 
determine the pinouts for the signals in the previous picture.

RJ45 Straight-
Through Cable (RS-
232 or RS-485 Half-
Duplex)

Use straight-through cables to connect modems and other DTE devices. For 
example, you can connect one end of a straight-through cable to COM2 on one 
computer and the other end of the straight-through cable to a modem.

RJ45 Loopback 
Plugs 

RocketPort EXPRESS models with RJ45 connectors are shipped with 
a a single loopback plug (RS-232/422).
Wire the following pins together to build additional loopback plugs or 
replace a missing RS-232/422 loopback plug:
• Pins 4 to 5
• Pins 1 to 8
• Pins 2 to 6 to 7
Wire the following pins together for an RS-422 loopback plug:
• Pins 4 to 5
• Pins 1 to 8

TxD
RxD
RTS
CTS
DSR

GND

DCD
DTR

Signal
RxD
TxD
CTS
RTS
DTR

GND

DCD
DSR

Signal
DB9

2
3
8
7
4

5

1
6

Pins
DB25

3
2

4

7

8
6

Pins
 RJ45

4
5
1
8
7

3

6
2

 Pins

20

5

 RocketPort DTE Serial Device

TxD+
TxD-
RxD+

Signal
 RJ45

1
4
8

 Pins

 

RxD+
RxD-

Signal

RxD-       5 
TxD+
TxD-

DTE Serial
Device

RocketPort

DB9

1
2
3
4
5

8

6
7

Pins
DCD
RxD
TxD         TRxD-
DTR
GND

CTS

DSR
RTS         TRxD+

Signal

DCD
RxD
TxD         TRxD-
DTR
GND

CTS

DSR
RTS         TRxD+ 

Signal

RI 9

RJ45

6
5
4
2
3

8

7
1

Pins

N/A

DB25

8
3
2
20
7

5

6
4

Pins

22 RI

RocketPort DCE Serial Device

RS-232   RS-485HD RS-232   RS-485HD

RS-232/422
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RJ11 Serial Cables and Loopback Plugs

RJ11 Serial Cables and Loopback Plugs

This section describes RJ11 cables and loopback plugs for the RocketPort 
EXPRESS 8J.
• RJ11 Signals
• RJ11 Null-Modem Cable (RS-232) on Page 19
• RJ11 Null-Modem Cable (RS-422 or RS-485 Full-Duplex) on Page 19
• RJ11 Straight-Through Cable (RS-232 or RS-485 Half-Duplex) on Page 20
• RJ11 Loopback Plugs on Page 20

RJ11 Signals There are no standards for RJ11 connector pinouts. Refer to the 
manufacturer’s installation documentation if you need help with 
connector pinouts or cabling for the serial device.
Note: Ring indicator, Request to Send, and Data Set Ready are not 

supported on the RJ11 connector.

RJ11 Null-Modem 
Cable (RS-232)

Use the following figure if you need 
to build an RS-232 null-modem 
cable. A null-modem cable is 
required for connecting DTE devices.

RJ11 Null-Modem 
Cable (RS-422 or RS-
485 Full-Duplex)

Use the following figure if you need to build 
an RS-422 null-modem cable. A null-modem 
cable is required for connecting DTE devices.
Note: RS-422 pinouts are not standardized. 

Each serial manufacturer uses 
various pinouts. Please refer to the 
documentation for the serial to 
determine the pinouts for the signals 
in the previous picture.

RJ11 Connector Signals

Pin RS-232 RS-422 RS-485
(Full-Duplex)

RS-485
(Half-Duplex)

1 DTR TxD+ TxD+ TRxD+

2 SIG GND SIG GND SIG GND SIG GND

3 TxD TxD- TxD- TRxD-

4 RxD RxD- RxD- Not Used

5 DCD Not Used Not Used Not Used

6 CTS RxD+ RxD+ Not Used

Ground must be tied to signal ground.

TxD
RxD

Signal
RxD
TxD
RTS

Signal
DB25

3
2

Pins
 RJ11

3
4

 Pins

4

 
RocketPort

DTE Serial Device
DB9

2
3
7

Pins

CTS 6

DCD
DTR DCD

DTR205
1 81

14
GND GND72 5

RS-232

TxD+
TxD-
RxD+

Signal
 RJ11

1
3
6

 Pins

 

RxD+
RxD-

Signal

RxD-      4 
TxD+
TxD-

DTE Serial
Device

RocketPort

RS-422/RS-485FD
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RJ11 Straight-Through Cable (RS-232 or RS-485 Half-Duplex)

RJ11 Straight-
Through Cable (RS-
232 or RS-485 Half-
Duplex)

Use straight-through cables to connect modems and DTE devices. For example, 
you can connect one end of a straight-through cable to COM2 on one computer and 
the other end of the straight-through cable to a modem.

RJ11 Loopback 
Plugs 

RocketPort EXPRESS models with RJ11 connectors are shipped with 
a a single loopback plug (RS-232/422).
Wire the following pins together to build additional loopback plugs or 
replace a missing RS-232/422 loopback plug:
• Pins 3 to 4
• Pins 1 to 6

DTR        TRxD+         1

DCD
RxD        
TxD         TRxD-
DTR        TRxD+
GND

Signal

DCD
RxD         
TxD         TRxD-

GND

Signal
RJ11

5
4
3

2

Pins
DB25

8
3
2
20
7

Pins

RocketPort DCE Serial Device

DB9

1
2
3
4
5

Pins

CTSCTS 6 58

RS-232   RS-485HD RS-232    RS-485HD
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Building Interfaces

This section discusses the following:
• 68-Pin VHDCI Connector (Quad/Octacable) on Page 21
• LFH60 and DB37M Multiplex Connectors DB9 and DB25 Interface Box Cable 

on Page 23

68-Pin VHDCI Connector (Quad/Octacable)

Use the following table if you need to build a cable for a proprietary serial device. 

Pin RS-232 RS-422 RS-485 FD RS-485 HD

1 TXD1 TXD-1 TXD-1 TRXD-1

2 RI1

3 DCD1

4 DTR1

5 RTS1 TXD+1 TXD+1 TRXD+1

6 DSR1

7 RXD1 RXD-1 RXD-1

8 CTS1 RXD+1 RXD+1

9 TXD2 TXD-2 TXD-2 TRXD-2

10 RI2

11 DCD2

12 DTR2

13 RTS2 TXD+2 TXD+2 TRXD+2

14 DSR2

15 RXD2 RXD-2 RXD-2

34
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68-Pin VHDCI Connector (Quad/Octacable)

16 CTS2 RXD+2 RXD+2

17 RJ45

18 SIG GND SIG GND SIG GND SIG GND

19 TXD3 TXD-3 TXD-3 TRXD-3

20 RI3

21 DCD3

22 DTR3

23 RTS3 TXD+3 TXD+3 TRXD+3

24 DSR3

25 RXD3 RXD-3 RXD-3

26 CTS3 RXD+3 RXD+3

27 TXD4 TXD-4 TXD-4 TRXD-4

28 RI4

29 DCD4

30 DTR4

31 RTS4 TXD+4 TXD+4 TRXD+4

32 DSR4

33 RXD4 RXD-4 RXD-4

34 CTS4 RXD+4 RXD+4

35 TXD5 TXD-5 TXD-5 TRXD-5

36 RI25

37 DCD5

38 DTR5

39 RTS5 TXD+5 TXD+5 TRXD+5

40 DSR5

41 RXD5 RXD-5 RXD-5

42 CTS5 RXD+5 RXD+5

43 TXD6 TXD-6 TXD-6 TRXD-6

44 RI6

45 DCD6

46 DTR6

47 RTS6 TXD+6 TXD+6 TRXD+6

48 DSR6

49 RXD6 RXD-6 RXD-6

50 CTS6 RXD+6 RXD+6

51 SIG GND SIG GND SIG GND SIG GND

52 SIG GND SIG GND SIG GND SIG GND

53 TXD7 TXD-7 TXD-7 TRXD-7

54 RI7

55 DCD7

56 DTR7

57 RTS7 TXD+7 TXD+7 TRXD+7

58 DSR7

59 RXD7 RXD-7 RXD-7

Pin RS-232 RS-422 RS-485 FD RS-485 HD
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LFH60 and DB37M Multiplex Connectors DB9 and DB25 Interface Box Cable

LFH60 and DB37M Multiplex Connectors DB9 and DB25 Interface Box Cable

Use the following table if you 
need to build an interface cable. 

60 CTS7 RXD+7 RXD+7

61 TXD8 TXD-8 TXD-8 TRXD-8

62 RI8

63 DCD8

64 DTR8

65 RTS8 TXD+8 TXD+8 TRXD+8

66 DSR8

67 RXD8 RXD-8 RXD-8

68 CTS8 RXD+8 RXD+8

Pin RS-232 RS-422 RS-485 FD RS-485 HD

Ports 1-16  Ports 17-32  
DB37-1 
Source

LFH60 
Dest Pair Signal DB37-2 

Source
LFH60 
Dest Pair Signal

J1-1 N/C J3-1 N/C

J1-2 J2-44 SIG GND J3-2 N/C SIG GND

J1-3 J2-43 SIG GND J3-3 J2-37 SIG GND

J1-4 J2-42 SIG GND J3-4 J2-36 SIG GND

J1-5 J2-41 SIG GND J3-5 J2-35 SIG GND

J1-6 J2-23 RESET J3-6 J2-8 RESET

J1-7 J2-46 1A RXCLK+ J3-7 J2-24 1A RXCLK+

J1-8 J2-16 2A RXDATA+ J3-8 J2-25 2A RXDATA+

J1-9 J2-17 3A RXDATB+ J3-9 J2-26 3A RXDATB+

J1-10 J2-18 4A RXCNVT+ J3-10 J2-27 4A RXCNVT+

J1-11 N/C J3-11 N/C

J1-12 J2-19 5A TXDATB- J3-12 J2-28 5A TXDATB-

J1-13 J2-20 6A TXDATA- J3-13 J2-29 6A TXDATA-

J1-14 J2-21 7A TXCLK- J3-14 J2-30 7A TXCLK-

J1-15 J2-22 8A TXCNVT- J3-15 J2-31 8A TXCNVT-

J1-16 J2-47 V+ J3-16 J2-54 V+

J1-17 J2-48 V+ J3-17 J2-55 V+
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LFH60 and DB37M Multiplex Connectors DB9 and DB25 Interface Box Cable

J1-18 J2-49 V+ J3-18 J2-56 V+

J1-19 J2-50 V+ J3-19 N/C

J1-20 N/C J3-20 N/C

J1-21 N/C J3-21 N/C

J1-22 J2-40 SIG GND J3-22 J2-34 SIG GND

J1-23 J2-39 SIG GND J3-23 J2-33 SIG GND

J1-24 J2-38 SIG GND J3-24 J2-32 SIG GND

J1-25 J2-45 1B RXCLK- J3-25 J2-7 1B RXCLK-

J1-26 J2-15 2B RXDATA- J3-26 J2-6 2B RXDATA-

J1-27 J2-14 3B RXDATB- J3-27 J2-5 3B RXDATB-

J1-28 J2-13 4B RXCNVT- J3-28 J2-4 4B RXCNVT-

J1-29 N/C J3-29 N/C

J1-30 J2-12 5B TXDATB+ J3-30 J2-3 5B TXDATB+

J1-31 J2-11 6B TXDATA+ J3-31 J2-2 6B TXDATA+

J1-32 J2-10 7B TXCLK+ J3-32 J2-1 7B TXCLK+

J1-33 J2-9 8B TXCNVT+ J3-33 J2-60 8B TXCNVT+

J1-34 J2-51 V+ J3-34 J2-57 V+

J1-35 J2-52 V+ J3-35 J2-58 V+

J1-36 J2-53 V+ J3-36 J2-59 V+

J1-37 N/C J3-37 N/C

Ports 1-16 (Continued) Ports 17-32 (Continued)
DB37-1 
Source

LFH60 
Dest Pair Signal DB37-2 

Source
LFH60 
Dest Pair Signal



RocketPort EXPRESS User Guide: 2000481 Rev. G Troubleshooting - 25

Troubleshooting

If you are experiencing problems with the RocketPort EXPRESS, review the 
troubleshooting procedures for your system before calling Technical Support.

Before Calling Technical Support

Review the following information before calling Technical Support because they 
will request that you perform many of the procedures or verifications before they 
will be able to help you diagnose a problem.
• Verify the cabling using Connecting Serial Devices on Page 11. 

Note: Most customer problems reported to Comtrol Technical Support are 
eventually traced to cabling or network problems.

• If you have not done so, run the diagnostics (RocketPort EXPRESS 
Diagnostics on Page 25).

• Verify that you have installed the latest RocketPort EXPRESS device driver, 
see Locating the Latest Drivers and Documentation on Page 5.
If necessary, remove or update the existing driver using the procedures in the 
RocketPort EXPRESS Device Driver Installation Guide for Windows or 
README file packaged with the Linux or QNX driver.

If none of the above work, you can refer to one of these subsections:
• Troubleshooting Windows Systems on Page 27
• Troubleshooting Linux Systems on Page 34

RocketPort EXPRESS Diagnostics

This subsection describes how to run the bootable diagnostic CD to verify that the 
RocketPort EXPRESS hardware is functioning properly. You can download (Page 
5) the RocketPort EXPRESS .iso file and burn a bootable CD that executes 
hardware diagnostics.
Note: An .iso file cannot be copied onto a CD but must be burned using an 

application that burns the image to the CD. If you do not have an 
application available, you can download a freeware application at: ftp://
ftp.comtrol.com/iso/IsoBurner/.

You can use the diagnostic to:
• Confirm that the hardware is functioning
• Determine resolutions to conflicts during installation
• Perform a stress test on all RocketPort EXPRESS ports in the system
The diagnostic requires a loopback plug to test a port or ports. A single loopback 
plug is shipped with the RocketPort EXPRESS. You can build additional loopback 
plugs or move the loopback plug to the port you want to test. See Connecting 
Serial Devices on Page 11 if you want to build loopback plugs.

ftp://ftp.comtrol.com/rport_express/diag
http://downloads.comtrol.com/iso/IsoBurner/
http://downloads.comtrol.com/iso/IsoBurner/
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Running the Bootable Diagnostic

Running the 
Bootable Diagnostic

Use the following procedure to run the diagnostics.
Note: If the diagnostic goes into sleep mode while unattended, press the Num Lock 

key to activate the screen. Use Ctrl/Alt/Delete to stop the diagnostic process 
at any time.

1. Insert the bootable CD that contains the diagnostic and restart your machine.
Note: If the Diagnostic CD does not boot the PC, you may need to change your 

BIOS settings so that the PC can boot from a CD drive.
The diagnostic starts automatically and takes a few minutes before the first 
screen appears.
Note: If the diagnostics did not detect the RocketPort EXPRESS, the adapter 

has a hardware failure, contact Technical support (Page 35).
2. Press Enter at the Copyright screen to begin the diagnostic.
3. Select from the following options and use the appropriate steps.

• Testing a Port or Ports
• Stress Testing the RocketPort EXPRESS

Testing a Port or 
Ports

4. Enter 1 to 4 and then press Enter to test a port or ports on a specific RocketPort 
EXPRESS or multiple adapters. 

5. Press Enter to test all ports on the RocketPort EXPRESS or enter the port 
number of a port that you want to test and then Enter.

6. Place the loopback plug on the appropriate port and press Enter. If you are 
testing all of the ports and have only one loopback plug, you must move it from 
port to port during the test.
Note: Use Shift Page Up/Down to review the diagnostic report. 

To end the diagnostic, you may need to select b to return to a screen that contains 
a q to quit. A summary is displayed if you select q. Type reboot, select Enter, and 
remove the CD from the drive when prompted.

Stress Testing the 
RocketPort 
EXPRESS

The stress test requires a loopback plug for each port on each card.
Select S and press Enter to run the stress test on all RocketPort EXPRESS cards 
installed in the system. Make sure that you have a loopback port installed and 
each port on each adapter.
The stress test uses a default configuration to simultaneously stream data to all 
ports of the RocketPort EXPRESS cards in a system until you stop the test. 
To stop the test and review the results of the stress test, enter S.

Exiting the 
Diagnostic

To end the diagnostic, you may need to select b to return to a screen that contains 
a q to quit. Type reboot, select Enter, and remove the CD from the drive when 
prompted.

If the Diagnostic 
Fails

If the diagnostics fails, try one of the following before contacting Technical 
Support:
1. Turn off the power and reseat the RocketPort EXPRESS card into the slot.
2. Try running the diagnostics again. If they fail again, you may have a bad port, 

contact Technical Support on Page 35.
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Troubleshooting Windows Systems

Troubleshooting Windows Systems

If you are using a RocketPort EXPRESS driver on a Windows system and the 
diagnostic verified that the card is functional, you can check the following:
1. Verify that the RocketPort EXPRESS has installed by checking the Device 

Manager to verify that the RocketPort EXPRESS card displays.
2. Verify that you are addressing the port correctly.

In many applications, device names above COM9 require the prefix \\.\ in 
order to be recognized. For example, to reference COM20, use \\.\COM20 as 
the file or port name.

3. After driver installation, if a port does not open; go to Ports COM & LPT, right-
click on the yellow exclamation mark on the port, and click Update Driver. Use 
the same procedure used when installing the ports that are detected with plug 
and play systems.

4. Enable the Verbose Event Log feature on the Options tab of the RocketPort 
EXPRESS driver and then reboot the server.

5. Install and use one of the tools in the Comtrol Utility package. Use the 
following subsection, Comtrol Utility, below for installation and adapter 
testing procedures.

Comtrol Utility The Comtrol Utility is available on the Software and Documentation CD or you 
can download (Page 5) the latest version. The file is a self-extracting zip file that 
automatically starts the installation procedure. It is not necessary to reboot the 
PC after installation.
The Comtrol Utility package includes the following applications that you can access 
from the Comtrol Program group:
• Port Monitor (PortMon2) checks for errors, modem control, and status signals. 

In addition, it provides you with raw byte input, output counts, and confirm 
that the device driver is functioning. It can determine if the ports are in use by 
another application.

• Test Terminal (WCOM2) can be used to troubleshoot communications on a port-
by-port basis (Using Test Terminal to Test a Port on Page 32). Test Terminal 
requires a loopback plug. You can build a loopback plug if you are missing the 
loopback plug shipped with the adapter (DB9 Loopback Plugs on Page 13).

Use the following 
procedure to install the 
Comtrol Utility package.
1. Execute the 

Comtrol_Utility_Pack
age_x.xx.msi file, 
where x_xx is the 
Comtrol Utility 
version number.

2. Click Next.









ftp://ftp.comtrol.com/utilities/windows/comtrol_utility
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Comtrol Utility

3. Click Next. 

4. Click Install.

5. Click Finish.
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Using PortMon to Test the Driver Installation

6. Go to Using PortMon to Test the Driver Installation on Page 29.

Using PortMon to 
Test the Driver 
Installation

You can use PortMon to check whether the RocketPort EXPRESS can 
communicate through the device driver for Windows. If necessary, use Comtrol 
Utility on Page 27 to install PortMon.
1. From the Start menu, select Programs > Comtrol > Utilities > Port Monitor 

(PortMon2).

2. Click Add Ports using the icon or Tools > Add Ports, click Driver, ROCKETPORT, 
and click Ok.
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Using PortMon to Test the Driver Installation

3. If the RocketPort EXPRESS is communicating with the device driver for 
Windows, Port Monitor should display CLOSED status. If a port is open for an 
application, it displays as OPEN, and displays Actual Throughput, TxTotal and 
RxTotal statistics.

Normally, there should be no data errors recorded or they should be very 
small. To find out what the actual errors are, scroll to the right. You will see 
three columns: Overrun Errors, Framing Errors, and Parity Errors.
If the errors are:
• Overrun Errors represent receive buffer overflow errors. If this is the case, 

you will have to configure either software or hardware handshaking to 
control the flow of data. The most common errors are Overrun errors.

• Framing Errors indicate that there is an synchronization error between the 
beginning of a data frame and the end of the data frame. A frame usually 
consists of a start bit, 8 data bits, and a stop bit or two. The framing error 
occurs if the stop bit is not detected or it occurs in the wrong time frame. 
Most causes for framing errors are electrical noise on the data lines, or 
differences in the data clocks of the RocketPort EXPRESS and the 
connected device.

• Parity Errors occur when parity is used and the parity bit is not what is 
expected. This can also be caused by noise on the data lines.
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Using PortMon to Test the Driver Installation

4. You can view additional statistics to Port Monitor by adding columns. Click 
Tools and Add Columns.

5. Highlight or shift-click to add multiple 
statistics and click Ok.
Note: See the Port Monitor help system 

if you need an explanation of a 
column.












6. Scroll to the right to view the new 
columns. 



32 - Troubleshooting RocketPort EXPRESS User Guide: 2000481 Rev. G

Using Test Terminal to Test a Port

7. If you want to capture this session, you can save a current session as a report. 
To do this, select one of the following save options:
• File > Save As 
• File > Save - if the report already exists in an older format

• Save Active Session  button

Reports can be opened, viewed and re-used when needed. To open and view a 
report: 
a. Select File > Open or the Open Existing Session  button. The Open 

Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.
Optionally, if you want to continue monitoring for an existing session, you 
need to activate the Polling Interval. 
• Select Tools > Settings to access the PMon2 Settings dialog
• Change the Polling Interval field to a value other than zero (0)

8. Leave Port Monitor open so that you can review events when using Test 
Terminal to test a port or ports.

Using Test Terminal 
to Test a Port

Test Terminal (WCom2) allows you to open a port, send characters and commands 
to the port, and toggle the control signals. This application can be used to 
troubleshoot communications on a port-by-port basis. 
The Send and Receive Test Data option sends data out the transmit line to the 
loopback plug, which has the transmit and receive pins connected thus sending 
the data back through the Rx line to Test Terminal, which then displays the 
received data in the terminal window for that port. This test is only testing the Tx 
and Rx signal lines and nothing else. This test works in either RS-232 or RS-422 
modes as both modes have transmit and receive capability. A failure in this test 
will essentially prevent the port from working in any manner.
The Loopback Test option tests all of the modem control signals such as RTS, DTR, 
CTS, DSR, DCD, and RI along with the Tx and Rx signals. When a signal is made 
HI in one line the corresponding signal line indicates this. The Loopback Test 
changes the state of the lines and looks for the corresponding state change. If it 
successfully recognizes all of these changes, the port passes. 
A failure on this test is not necessarily critical as it will depend on what is 
connected and how many signal lines are in use. For example, if you are using RS-
232 in 3-wire mode (Transmit, Receive and Ground) a failure will cause no 
discernible issue since the other signals are not being used. If the port is 
configured for use as either RS-422 or RS-485 this test will fail and is expected to 
fail since RS-422 and RS-485 do not have the modem control signals that are 
present in RS-232 for which this test is designed.
The following procedure shows how to use Test Terminal to send and receive test 
data to the serial ports and run a loopback test. If necessary, install the Comtrol 
Utility package using Comtrol Utility on Page 27.
1. Stop all applications that may be accessing the ports such as RRAS or any 

faxing or production software. See the appropriate help systems or manuals 
for instructions on stopping these services or applications. 
If another application is controlling the port, then Test Terminal will be unable 
to open the port and an error message will be shown.

2. From the Start menu, select Programs > Comtrol > Utilities > Test Terminal (WCom2).
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Using Test Terminal to Test a Port

3. Select File > Open Port, the 
appropriate port (or ports) 
from the Open Ports drop list 
and Ok.
Note: If you left Port Monitor 

open from the previous 
subsection, you should 
show that the port is 
open.

4. Install the loopback plug (DB9 
Loopback Plugs on Page 13) 
onto the port (or ports) that 
you want to test.

5. Select Port > Send and Receive 
Test Data.

You should see the 
alphabet scrolling 
across the port. If so, 
then the port installed 
properly and is 
operational. 
Note: If you left Port 

Monitor 
running, it 
should show 
data sent and 
received and 
show the 
average data 
throughput on 
the port.

6. Select Port > Send and 
Receive Test Data to stop 
the scrolling data.

7. Select Port > Loopback 
Test.
This is a pass fail test and will take a second or two to complete. Repeat for 
each port that needs testing.
The loopback test test the modem control (hardware handshaking) signals. It 
only has meaning in RS-232 mode on serial connector interfaces with full RS-
232 signals. If performed under the following conditions, the test will always 
fail because full modem control signals are not present:
• RS-422
• RS-485
• RJ11 connectors

8. Close Test Terminal

If both of these tests successfully complete, then the port is operational as 
expected.
Note: Do NOT forget to restart the communications application.
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You can use the following subsections to test the serial ports. 

lcom(1) Comtrol has available lcom(1), which is a multiport serial I/O test program. You 
can use lcom in test mode to send test data to any serial port.
lcom is available on the Software and Documentation CD or you can download the 
latest version.
Note: For assistance using lcom, use the manual page, lcom(1) that accompanies 

the program.

File Transfer You can transfer a file using the following information. The default settings are 
9600, 8, n, 1, and no parity. To send a file you can redirect output to a device; for 
example:

cat /etc/inittab > /dev/ttyRP0

Sends the contents of the /etc/inittab file to the ttyRP0 device at 9600 baud, 8, n, 1, 
and no parity.

Changing Serial 
Port Settings (stty)

Use the following information if you need assistance changing or viewing the baud 
rate settings.
To change the baud rate, use the following example, which changes the baud rate 
to 19200:

stty 19200 </dev/ttyRP0

To view the current serial port settings for ttyRP0, enter:
stty -a </dev/ttyRP0

Note: Settings changes via stty are only valid during current log in session. For 
permanent setting changes, use the /etc/inittab file.

Setting Up 
Terminals and 
Modems (mgetty, 
getty)

Add the appropriate line or lines to the /etc/inittab file then restart.
Terminal Example:

T0:23:respawn:/sbin/agetty -L ttyRP0 57600 vt100

Modem Example:
T1:23:respawn:+/sbin/mgetty -m ‘”” AT&F OK’ -D -x9 -s 115200 ttyRP0

Note: If necessary, see the manual pages for more information on mgetty.

Testing with 
minicom

You can also use minicom, which shipped with most Linux distributions, to test the 
serial ports. A Comtrol document is available for using minicom.

ftp://ftp.comtrol.com/tech_misc/linux/minicom_doc/minicom.txt
ftp://ftp.comtrol.com/utilities/linux/lcom/v1_01
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Comtrol has a staff of support technicians available to help you. You should review 
Before Calling Technical Support on Page 25 before calling Technical Support. If 
you call for Technical Support, please have the following information available:
• Model number
• Serial number
• Interface type
• Operating system type, release, and service package, and if Linux, the kernel 

version
• Device driver version
• Computer make, model, speed, and single or dual processor
• List other devices in the computer and their addresses

Comtrol Corporate Headquarters

Support http://comtrol.com/Support

Device drivers ftp://ftp.comtrol.com/html/rp_express_drivers.htm

Diagnostic and 
Utilities ftp://ftp.comtrol.com/html/rp_express_diag.htm

User Guides ftp://ftp.comtrol.com/html/rp_express_docs.htm

Web site http://www.comtrol.com

Phone 763.957.6000

Downloads http://downloads.comtrol.com/html/default.htm

ftp://ftp.comtrol.com/html/rp_express_docs.htm
http://comtrol.com
http://comtrol.com/Support
ftp://ftp.comtrol.com/html/default.htm
ftp://ftp.comtrol.com/html/rp_express_diag.htm
ftp://ftp.comtrol.com/html/rp_express_drivers.htm
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